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INTRODUCTION

Welcome to Mario's FUNdamentals, a collection of five gamesto
challenge you for hours. In each game, Mario™ will be
your opponent and encourage you to play and strive for your
maximum playing potential.

Many of your favorite characters from Super Mario World™ will
make appearances on game pieces and cards, adding to the overall
fun and excitement! You'll play with Yoshi™, Koopa™, and other
well-known characters. So, get ready to improve your game-
playing abilities with Mario and his wacky friends.

2 BRAINSTORM



MACINTOSH INSTALLATION

SYSTEM REQUIREMENTS

Mario's FUNdamentals™ CD for the Macintosh requires any
256-color Macintosh with 1700K free memory (2048K recom-
mended), 7MB free hard disk space, System 7.0 or later, and a
CD-ROM drive.

INSTALLING THE GAME

1. Insert the Mario’s FUNdamentals game disc into the
CD-ROM drive. Double-click the Installer icon and follow the
instructions on your screen.

2. You can install two versions of Mario’s FUNdamentals™ to
your hard disk. Choosing “Standard Install” in the Installer
will take up 7MB of hard disk space. If you have more than
7MB available, you can optionally perform the “Big Install,”
which will take up atotal of 10MB of hard disk space. The
Big Install features better sound quality but takes up 3MB
more space. It's your decision.

3. After installing the program to your hard disk, you don’'t need
to insert the CD-ROM disc to play. Simply double-click the
“Mario’'s FUNdamentals’ icon on your hard disk to begin.

NOTES

Owners of a12” monitor or a Macintosh Color Classic: Hold
down the Command key to hide or un-hide the menu bar.

For Macs with two or more monitors: Please make sure both
monitors are set to 256 colors before you begin game play.

Is Mario taking too long to think about his Checkers move? If you
want Mario to stop thinking about his Checkers move, you can
press the space bar to make him go ahead and make the best move
he has come up with so far.
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WINDOWS/WIN 95 INSTALLATION

SYSTEM REQUIREMENTS

Mario's FUNdamentals CD for the IBM™, Tandy™ and 100%
compatibles requires a 486/33 or faster microprocessor, DOS 5.0
or later, Windows 3.1 or Windows 95, SMB RAM minimum
(520K conventional memory for Windows version — refer to your
DOS manual), a 256-color VGA monitor, 10MB free hard disk
space and a double speed or faster CD-ROM drive.
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WINDOWS™ INSTALLATION
Make sure you have Windows installed properly.
Insert the Mario’s FUNdamentals game disc into the
CD-ROM drive.

3. Open the Windows Program Manager.
4.
5. Type the drive letter for your CD-ROM drive followed by

Select the File menu, then select “RUN.”

acolon (: ), abackslash (\) and the following letters:
brainstorm\mariofun\install.exe
Press the “Enter” key.

. After the install, double-click the Brainstorm icon, then

double-click the Mario icon to start Mario’'s FUNdamentals.

WINDOWS™ 95 INSTALLATION

. Make sure you have Win 95 installed properly.
. Insert the Mario’s FUNdamentals game disc into the

CD-ROM drive.

. Click on “D” drive.

. Double-click on “Install.exe”

. Follow the installation instructions on your screen.

. After the install, double-click the Brainstorm icon, then

double-click the Mario icon to start Mario’s FUNdamentals.
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TROUBLESHOOTING FOR WINDOWS
During the installation you are given the choice of four songs to
play, and you must choose the best one. If you don’'t hear any
sound, continue the install. Start Mario’'s FUNdamentals, go to the
Options menu and turn the Music off. If you get an error message,
disable it and choose “OK.” Turn the Music back on in the
Options menu. Music and Sound will play. Call our customer
service line for further assistance.

MAIN MENU SCREEN

Gy FISH

DOMIMDES

B CE G TN

TACHT

You will see Mario standing next to a signboard that lists the five
games available in his gallery. Choose from Mario's signboard by
clicking on the game title with the mouse, or by typing the first
letter of the game followed by [ENTER].
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GAME MENUS

All of the options can be activated by placing the cursor over the
option and pressing the mouse button, or by pressing the appro-
priate letter and then the “Enter” key. The Five games have the
same options in the File menu, Options menu (Checkers and
Backgammon have additional selections), and the Help menu.

THE FILE MENU

New Game starts another game.

Exit to Main Menu takes you back to the Main Menu Screen.

THE OPTIONS MENU

Change Name: This option gives you the ability to give
yourself a different name.

Music: You can turn the music off or on.

Sound: You can toggle the sound off and on.
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Along with Change Name, Music, and Sound, two of the games
have an additional option under the Options Menu.

Play Game

as 5
& £

Let’s play, eh?

CHECKERS
Forced Jump: This option forces both sides to capture the
opponent’s pieces whenever possible before any other move. If
you are able to capture one of Mario’s pieces, you must do so.

BACKGAMMON
Animated Pieces: This option turns character animation on
and off.

THE HELP MENU

The Help menu gives you some information on how to play a
game. Press the first letter of the game that is listed in the help
menu. If you need additional information on a specific game,
please read further into the the manual.
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CHECKERS

he object of Checkersisto capture all of Mario's pieces.

You and Mario are each given 12 pieces. They are posi-
tioned on the black squares of the first three rows on opposing
sides of the board. After you have chosen either Yoshi or Koopa
to be your pieces, you will make the first move. TypeY or K or
use your cursor to click (pressing the mouse button) on one of the
two options of Yoshi or Koopa.
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To move, select one of your pieces (place the cursor over the
piece and press the mouse button) and then select the square to
which you want the piece to move.

The pieces (Yoshis and Koopas) are moved diagonally forward
one sguare at atime. A piece can be captured when thereisa
vacant spot diagonally behind it. You can capture more than one
piece a atime if there are empty squares between them on the
same diagonal. If you have checked the Forced Jump rule in the
Options menu, you must capture a piece if possible.

When a piece reaches its opponent's end of the board, it is
crowned a "King." Kings can move both forward and back-
ward on the diagonals. Once a player has either eliminated or
blocked all of his opponent's pieces, the game is ended.

May all of your pieces become Kings!
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he object of Go Fish isto complete the most "books" (four

of the same card). You and Mario are each dealt seven
cards out of atotal of 52. There are 13 possible "books" to be
made. A number in the upper left-hand corner of the card will tell
you how many of those cards you have. For instance, if you have
aLuigi™ card with anumber “3” in the upper left-hand corner,
you know that you have three Luigis in your hand and are one
card away from completing a book.

5 FUndem
= Fundsmentul
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=== ====] You and Mario will be dealt

= seven cards, which will appear
along the bottom of the screen.
The game begins with Mario
going first. Mario will ask if
you have a particular card and
the card that Mario asks for
will automatically be removed
from your hand if you have it.
Mario's turn will continue until he is unable to make a match with
any of your cards. At this point, you will tell Mario to "Go Fish"
and he will draw a card from the Go Fish pile. If heis successful
in drawing the card he asks for, his turn will continue; if not, it
becomes your turn.

Yoz, | have one card

To ask Mario for a particular
card, click on a card in your
hand. If he hasthat card in his
hand, he will give it to you. If
Mario does not have the card
you asked for, you must go
fishing and draw one card
from the Go Fish pile by
clicking on it; if the card that
you draw is the card that you
asked for, you get to go again.

That's ansihsr Besk For vou

When a player has put together four of akind, that "book™ will
leave his hand and be noted on the scoreboard. A running tally of
your Books and Cards will be displayed on the upper right-hand
corner of the screen. Turns will alternate until there are no cards
left in the pile. At the end of the game, whoever has the most
completed books wins.

Now get ready and " Go Fish!"
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DOMINOES

his game is Mario's version of Dominoes, caled Boneyard.

You will be dedt seven dominoes, which will appear dong the
bottom of the screen. The player who has been dealt the highest
doublet (both halves of domino are the same) will go first.

The object of Dominoes isto get rid of your tiles (dominoes)
before Mario does. Each tile has two sides on which thereisa
picture and a number. There are atotal of 28 different tilesin the
game. Instead of counting dots (regular dominoes), you will match
pictures and numbers on the dominoes.

To play atile, you must first click on it in your hand, then drag it
to the domino field, then click on it again when you have matched
one-half of your domino with another domino.

If you cannot match a domino with another tile on the playing
field, you must go to the Boneyard.
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The Boneyard is located on the lower right-hand side of the
screen. You will move the mouse to the Boneyard and draw until
you can make a match. Below the picture of the bone, thereis a
number that shows how many dominoes are left to be drawn.

On rare occasions, a block can occur. This happens when a player
has drawn all of the dominoes from the boneyard and cannot play
any, and the other player has no place to put atile on the field.
The player with the least number of tiles |eft in their hand would
win the game.
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I really enjoy playing with youl

Have a great time!
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BACKGAMMON

he object of Backgammon is to remove al of your pieces
from the board before Mario removes al of his. The first
one to do this, called "Bearing Off," wins the game.

In Backgammon, the board has four separate areas. your outer and
inner tables, and Mario's outer and inner tables. You will move
clockwise and Mario will move counterclockwise. When all of
your Yoshis or Koopas are in their inner table, you can begin to
remove them from the board. The same appliesto Mario with his
pieces.

Before you begin playing Backgammon, you must first choose
your pieces by typing aY (for Yoshis) or aK (for Koopas). Then,
both you and Marioroll the dice to see who playsfirst. The
highest number starts.
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Turns are taken alternately by rolling the dice. You can move one
piece equaling the sum of your dice or by splitting the two dice
between two pieces. An example of thiswould be aroll that
resulted ina5 and a2. You could either move one piece 7
spaces, or move one piece two space and move another five.

To move, click on one of your
pieces, and then click on the place
where you want the piece to go. If
you accidentally click on a piece
that you do not want to move,
click on it again and then you can
click on the desired piece. After
the pieces have moved to their
destinations, they cannot move
back to their previous positions.

When doubles are thrown (two of
one number), twice the amount of
the original roll can be moved.
For instance, if you rolled two 4s,
atotal of 16 spaces are moved
(4+4+4+4=16).

When two or more of your pieces rest on a space, Mario's pieces
cannot stop there, and two or more of Mario’s pieces rest on a
space you cannot stop there. However, if a space has one of
Mario’'s pieces on it and then your pieces land there, Mario’s
piece is removed from the table and placed on the "bar” (The bar
is a place where pieces go after they have been “knocked” off a
space by an opposing piece. It islocated in the middle of the
board and pieces will automatically be placed there if knocked out
of position.) The result would be the same if one of Mario's pieces
lands on a space where you only had one piece — your piece
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would go to the bar. When a piece is placed on the bar, it can
only re-enter when the dice roll enables the piece to land on a
space not occupied by two or more of the opposing pieces. If the
piece on the bar can’t enter with the roll, the person who rolled
must pass his turn. For instance, if you roll a6 and a 2 and mov-
ing six or two places off the bar will cause you to land on a space
where two or more of Mario’spieces rest, you must pass. Notice
that you can’t move eight, as you must be able to move to a space
equal to the amount of at least one die.

He,.r | gal daublesl

The pieces can be moved off the board when all of them arein
their inner board. Once in their inner table, the dice will be
rolled, and the pieces can be moved equal to the amount on the
dice. Thedicerolls must equal or be greater than the number
spaces to get off the board. Example: If you rolled a 3 and a 4, but
it takes al of your pieces five places to get off the board, you
could only move one piece off the board (because you have at
least five by adding the two dice) or move one piece three spaces
and another piece four spaces (but those pieces will remain in the
inner table).

Good Luck!
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D nYacht, you and Mario are each allowed twelve turns to fill
your scorecard. The winner of Yacht will have the highest total
number which will be indicated on the bottom of their scorecard.
In each turn, you and Mario are given a maximum of three rolls of
the dice to select a scoring combination. Although you are allowed
up to three rolls, you can stop after your first or second roll.

Mario will go first inYacht. On your first roll, five dice are
thrown. If you like what you roll, you can keep all the dice or
you can select the dice that you want. (Use your cursor and place
it on the dice that you like, then press the mouse button.) On the
second or third roll, you can pick up any or all of your diceto try
again. The dice that you decide to "keep" will change color.
On each roll of the dice, the scorecard will show the possible
categories to choose from. To choose one of the categories on
the scorecard, place the cursor over what you like, then press
the mouse button.

MARIO’'S FUNDAMENTALS 17



There are 12 scoring categoriesin Yacht. They are: Aces (Ones),
Deuces (Twos), Threes, Fours, Fives, Sixes, Choice, Full House,
Four Of A Kind, Small Straight, Big Straight, and Yacht. You can
only use a category once, so if you end up having a dice roll that
does not fit any of the available categories, you must fill an entry
and receive a score of “zero.” For instance, this might occur if you
fill all of your categories on the scorecard except a Full House
and the last roll you receive is not a Full House. Another example
isif you receive adiceroll of threes and fours, but you choose the
Deuces (twos) option on the scorecard or something else that does
not reflect your diceroll. You must fill the available entry even
though you will receive a score of “zero.”

The Aces (Ones), Deuces (Twos), Threes, Fours, Fives, and Sixes
are categories in which you must get the exact “number”’ to score
in other than zero. For instance, you can only score in the Deuces
(Twos) category by rolling Deuces (Twos), you can only score in
the Fives category by rolling fives, etc. The scorecard will add up
the like dice and fill the appropriate category.

A further exampleisif you roll two threes, one Ace (a one) and
two fives; You can fill the Threes category in which you will
receive a score of 6 (3+3=6), you can fill the Aces category in
which you will receive a score of 1, you can fill the Fives catego-
ry in which you will receive a score of 10 (5+5=10), or you do
not have to accept anything and roll again. Since you rolled two
threes and two fives, you can attempt to roll the one Ace to try to
get a Full House.

A "Full House" is any combination of three of akind and a two of
akind. It is scored by adding the total of the dice. For instance, if
you rolled two fours and three twos, you would receive a score of
14 (2+2+2+4+4=14). The highest possible Full House is three
sixes and two fives. The lowest possible Full House is three ones
and two twos.
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A "Four Of A Kind" isfour like dice: four fives, four sixes, four
twos, etc. The categories of Aces, Twos, Threes, Fours, Fives, and
Sixes can be scored as a Four Of A Kind; however, Four Of A
Kind takes the total of four like dice and the fifth. The categories
of Aces through Sixes only would take the like dice.

For example, if you rolled four sixes and one five (on your last
roll), you can fill the Sixes category on the scorecard and receive
ascore of 24 (6+6+6+6=24) or fill the Four Of A Kind category
and receive a score of 29 (6+6+6+6+5=29).

SMALL STRAIGHT
"Small Straight” is made up of four sequential numbers. All
"Small Straights" are given a score of 25 points and there are
three possible combinations. They are:

1) Ace, Deuce, Three, Four.
2) Deuce, Three, Four, Five.
3) Three, Four, Five, Six.
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BIG STRAIGHT

A "Big Straight" is made up of five sequential numbers. A Big
Straight is given a score of 30 points and there are two possible
combinations. They are:

1) Ace, Deuce, Three, Four, Five.

2) Deuce, Three, Four, Five, Six.

CHOICE CATEGORY
A "Choice" category can be filled by totaling any combination of
five dice.

Chaoine —rE Chaoine

Fives Fives

Frosirs Frosirs
Threes Threes
Diemices Diemices
Aoey = Aoey
TOTAL 7 i (| B | S (e TOTAL

YACHT
A “Yacht” isfive like dice such as five Aces, five Deuces, five

Threes, etc. A “Yacht” is worth 50 points and is the highest
category to score in.

After you and Mario have taken 12 turns apiece, your total scores

will appear on the bottom of your score cards. The player with
the highest number wins.

Now, put on your thinking cap and have fun!
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CUSTOMER SUPPORT

If you have any questions about this or any other Brainstorm product, you
can reach our Customer Service/Technical Support Group at:

Brainstorm
16815 Von Karman Avenue
Irvine, CA 92606

Atin: Customer Service.

Customer Service is available 24 hours a day through our Automated
Customer Service system, with a Customer Service representative available
during normal business hours at (714) 553-6678.

Please have your system information available, or better yet, iry to be at
your computer. The more detailed information you can provide our sup-
port personnel, the better service we can provide you.

If you have a modem, you can reach us at the following:
America Online: Coming this fall!
CompuServe: (oming this fall!

Internet: You can reach Brainstorm by sending Internet E-mail to
“suppori@brainstormfun.com”. Many Brainstorm demos and paiches are
available at Internet FTP sites. To visit our World Wide Web site, point
your browser to: “http://www.brainstormfun.com” or you may FIP to
ftp.brainstormfun.com.
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LIMITED WARRANTY

BRAINSTORM LIMITED 90-DAY WARRANTY

Brainstorm warrants to the original purchaser of this Brainstorm™ product that the compact disc or floppy disk(s)
on which the software programs are recorded will be free from defects in material and workmanship for 90 days
from the date of purchase. If the compact disc or floppy disk(s) is found defective within 90 days of original pur-
chase, Brainstorm agrees to replace, free of charge, any product discovered to be defective within such period upon
receipt af its factory service center of the produdt, postage paid, with proof of the date of purchase. This warranty is
limited to the compact disc or floppy disk(s) containing the software program originally provided by Brainstorm and
is not applicable to normal wear and tear. This shall be void if the defect has arisen through abuse, mistreatment,
or neglect. Any implied warranties applicable to this product, including warranties of merchantability and fitness for
a particular purpose are disclaimed. Brainstorm disclaims all responsibility for incidental or consequential damages.

Some states do not allow limitations as to how long an implied warranty losts and/or exclusions or limitations of
incidental or consequential damages so the above limitations and/or exclusions or liability may not apply o you.
This warranty gives you specific rights, and you may also have other rights which vary from state to state.

Lifetime Warranty

If the compact disc or floppy disk(s) should fail after the original 90-day warranty period has expired, you may
return the software program to Brainstorm at the address noted below with a check or money order for $5.00 (U.S.
currency), which includes postage and handling, and Brainstorm will mail a replacement to you. To receive a
replacement, you need to enclose the original defective compact disc or floppy disk(s) in protective packaging
accompanied by: (1) a $5.00 check or money order, (2) a brief statement describing the defect, and (3) your
return address. If you have a problem with your software, you may wish to call us first at (714) 553-6678. If your
compact disc is defective and a replacement is necessary, U.PS. o registered mail is recommended for returns.
Please send the defective disc(s) only (nof the box) with a descripfion of the problem and $5.00 to:

Warranty Replacements
Brainstorm
16815 Von Karman Avenue
Irvine, CA 92606

COPYING PROHIBITED
This software product and the manual are copyrighted and all rights are reserved by Brainstorm and are protected
by the copyright laws that pertain to computer software. You may not copy the software except that you may make
one copy of the software solely for hackup or archival purposes. You may not loan, sell, rent, lease, give, sub
license, or otherwise transfer the software (or any copy). You may not modify, adapt, translate, create derivative
works, decompile, disassemble, or otherwise reverse engineer or derive source code from, all or any portion of the
software or anything incorporated therein or permit or encourage any third party fo do so.

NOTICE: Brainstorm reserves the right fo make modifications or improvements fo the product described in this
manuval af any time and without notice.
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(= sV-\[\\I-agelZ{ V-] WORLD WIDE WEB

Welcome to the Brainstorm Web! As a company dedicated to providing innovative,
high-quality interactive entertainment software, we are always striving to stay as close
as possible to the leading edge of technology. This Web site is the latest example of our
ongoing effort to provide awealth of information and opportunities to you.

As a company of fanatic gamers, we love the idea of gamers all over the world tapping
into cyberspace to see, touch and feel our latest games. No hype, no marketing cam-
paign; just great games. To make it work, our goal isto keep this site fresh and new, to
make it aplace where you can tell US what you like about our games... and what you
don't like about them. So use the feedback options on these pages and sound off.

Enjoy your visit in our Web site, explore all the different areas we have to offer, and
come back soon. Check us out in the weeks and months ahead; we will be introducing
new and exciting areas for you to experience.

Once again, Welcome!

Brian Fargo

HOW TO
GET THERE

Brainstorm'’s

World Wide Web site is
an Internet service
designed to give you
the latest information
about Brainstorm and
our products.

The site features our demos, upgrades, product information
and ordering information.

From your Internet account, point your favorite browser to:
http://www.brainstormfun.com
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